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[Abstract] In vivo sweat quantitation assays are required for the development of drugs for the 
management of focal hyperhidrosis before clinical trials; however, in vivo assays, particularly mouse 

models, are rare. Even in sweat assays using mice, sweating is quantitated by manually counting the 
number of sweating spots, which can contribute to various errors owing to arbitrary judgment. In this 

study, we developed a mouse sweat-assay model and a method for quantitating the amount of sweating 
to remove possible errors. The use of the iodine-starch test in the castor oil-covered hind footpad skin 

of anesthetized mice resulted in the sweating area being stained blue-black. After the anesthesia and 
treatment with drugs (pilocarpine, glycopyrrolate, botulinum neurotoxin, myricetin, and myricetin-loaded 

lipid nanoparticles), the remaining area of the footpad skin was eliminated from the acquired footpad 
images using ImageJ. Blue pixels extracted from the footpad image are automatically adjusted using 

the Phansalkar method, where the percentage of the blue area was determined based on the whole 
hind footpad skin area, finally indicating the percentage of the sweating area. Using this mouse model 

and analysis for sweat assays, a clear difference between the control group and antiperspirant-
administered group was observed with respect to the sweating area % with no error. In conclusion, this 

assay can be used as a preclinical tool to screen potential antiperspirant drugs. 
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Graphic abstract: 
 

 
Overview of the mouse-model sweat assay and objective quantitation of the focal sweating area 
 
Keywords: Sweat assay, Mouse model, Sweat quantitation, Mouse hind footpad perspiration, Non-

arbitrarily judged quantitation 

 
[Background] Numerous populations – nearly 3% of people aged 25-64 years – experience focal 

hyperhidrosis, an idiopathic abnormality characterized by hyper-sweating concentrated in certain 
regions of the body, e.g., palms, soles, face, and armpits (Haider et al., 2005). It interferes with daily 

activities; therefore, this condition poses substantial emotional, psychological, social, and professional 
burden (Strutton et al., 2004) and even leads to social anxiety disorders (Solish et al., 2007). During the 

development of drugs or medications for the treatment of focal hyperhidrosis, rational assays for 

evaluating sweating are necessary to evaluate excessive perspiration symptoms. Several tests used in 
clinical practice and research studies are not sensitive enough to detect subtle perspiration changes 
resulting from medications (Provitera et al., 2010). The thermoregulatory sweat test stimulates entire 

body sweating, including central and peripheral components, but does not localize the sweating lesion 
site (Fealey et al., 1989). Simple colorimetric procedures, such as the Neuropad test, evaluate sweating 
abnormalities but do not provide detailed analysis (Quattrini et al., 2008). In addition, abundant in vivo 

preclinical data are necessary for the verification of anti-perspiration efficacy before clinical trials; 
however, studies, particularly using mouse models, are rare. 

The iodine-starch test is a well-known chemical reaction between starch and iodine, which instantly 
produces an intense blue-black color. The test was first described in 1814 (Colin et al., 1814) and first 

applied in 1928 as a medical test for visualizing sudomotor function (perspiration or sweating) (Minor, 
1928). Polyiodides complexed with the amylose helix in starch form infinite polyiodide homopolymers 

and produce the blue-black color, whereas non-ionized iodine dissolved in nonpolar solvents and 
individual iodide (I−) do not react with starch (Madhu et al., 2016). The triiodide (I3−) ion is the simplest 

polyiodide, which is yellow-to-brown in aqueous conditions with no starch. In addition, the blue-black 
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color of the triiodide-starch complex is so deep, which can also be detected visually when the 

concentration of iodine is as low as 2 × 10−5 M at 20°C. Consequently, the iodine-starch test has been 
used as a well-established diagnostic tool to evaluate underactive (hypohidrosis) and overactive 
(hyperhidrosis) sweating (Chia et al., 2013). 

Even in the mouse sweat assays, various errors may occur owing to arbitrary judgment because the 

number of sweating spots, attributed to the iodine-starch reaction, is manually counted to quantitate the 
sweating score (Nejsum et al., 2002; Liu et al., 2017). For the data analysis, image-processing using 

ImageJ, a free software provided by the National Institutes of Health (NIH), can be utilized to eliminate 
possible arbitrary judgment and errors. In this protocol, we generated a mouse sweat-assay model and 
used ImageJ for image analysis (Ban et al., 2020). The sweating area on the skin of hind footpads of 

anesthetized mice was stained blue-black using an iodine-starch test. The blue-black pixels were 

extracted from the footpad images obtained, adjusted using the Auto Local Threshold function in ImageJ, 
and measured to the area fraction (sweating area %). Using the present protocol, a clear difference 

between the control and the antiperspirant-administered mice was observed with respect to the sweating 
area % with no error. Moreover, whether expected antiperspirants exploit either circulatory-systematic 

or focal anti-perspiration efficacy can also be assessed using this protocol. 
 
Materials and Reagents 

 

1. Pipet tips, 20 µl, 200 µl, and 1,000 µl (Gilson, catalog numbers: F161671, F1739311, and 

F161451, respectively) 
2. 0.2 μm syringe filter 

3. Conical tube with lid, 50 ml (SPL Life Sciences, catalog number: 50050) 
4. Microtubes, 200 µl and microtube 1.5 ml (Sigma-Aldrich, catalog number: Z374873; Eppendorf, 

catalog number: EP0030125150) 
5. Sterilized needles for syringe, 17 gauge (Korea vaccine) 

6. Sterilized syringe filter (Sartorius, catalog number: 17764-ACK) 
7. Sterilized syringes for general use, 1 and 50 ml (Korea vaccine) 

8. Mice (6-week-old Institute of Cancer Research, weighing 25-35 g; Koatec Co., Pyeongtaek, 
Korea) 

9. Myricetin (Sigma-Aldrich, catalog number: M6760) 
10. Glyceryl tristearate (Sigma-Aldrich, catalog number: T5016) 

11. Glyceryl trioctanaote (Sigma-Aldrich, catalog number: T9126) 
12. Brij S100 (Sigma-Aldrich, catalog number: 466387) 

13. Pluronic P-123 (Sigma-Aldrich, catalog number: 435465) 
14. Pilocarpine hydrochloride (pilocarpine) (Tokyo Chemical Industry, catalog number: P0434) 

15. Glycopyrrolate bromide (glycopyrrolate) (Tokyo Chemical Industry, catalog number: G0392) 
16. Neuronox 100U (botulinum neurotoxin type A, BoNT/A) (Medytox) 

17. Alfaxalone solution, 10 mg/ml (Alfaxan) (Alfaxan Multidose, Jurox Animal Health) 

http://www.bio-protocol.org/e4047
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18. Xylazine hydrochloride solution, 23.32 mg/ml (Rumpun, Bayer) 

19. Starch (Millipore, catalog number: 101252) 
20. Castor oil (Sigma-Aldrich, catalog number: 259853) 

21. Iodine (Sigma-Aldrich, catalog number: 207772) 
22. Ethanol (Sigma-Aldrich, catalog number: 02891) 

23. Dimethyl sulfoxide (DMSO) (Sigma-Aldrich, catalog number: 276855) 
24. HyClone phosphate-buffered saline, pH 7.4 (PBS) (GE Healthcare, catalog number: 

SH30256.01) 
25. Rumpun solution (see Recipes) 

26. Anesthesia solution (see Recipes) 
27. Pilocarpine solution (see Recipes) 

28. Glycopyrrolate solution (see Recipes) 
29. Myricetin solution (see Recipes) 

30. Myricetin-loaded lipid nanoparticles (M-LNPs) (see Recipes) 
31. Starch solution (see Recipes) 

32. Iodine solution (see Recipes) 
 
Equipment 
 

1. Pipets (20, 200, and 1,000 µl) (Gilson, catalog numbers: FA10003M, FA10005M, and 
FA10006M, respectively) 

2. Electric pharynx 

3. Pioneer analytical balance, capacity 320 g (Ohaus, model: PX323E) 

4. Cages for stabilizing between the time of anesthetic injection and complete anesthesia 
5. Paintbrushes to apply iodine and starch solutions on the hind footpads of mice 

6. Digital camera (Canon, model: EOS 800D) 
7. Mouse restrainers were prepared by making holes in the plastic wall of conical tubes and the lid 

using an electric pharynx (Figure 1) 
 
Software 
 

1. ImageJ (NIH, http://rsb.info.nih.gov/ij/) for image-processing and determination of the sweating 
area % 

2. SigmaPlot 10.0 Windows version (IBM Co.) for drawing graphs 
3. SPSS Statistics version 23.0 software (IBM Co.) for the statistical analyzes 

 
Procedure 
 

http://www.bio-protocol.org/e4047
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Male mice (5 mice per cage) were housed at a temperature of 21 ± 1°C and a humidity of 55 ± 10% 
under controlled laboratory conditions and maintained with food and water ad libitum. Mice were tested 

during the light phase of a 12-h light cycle (lights on at 6:00 am and off at 6:00 pm). 

A. Anesthesia 
1. Six-week-old Institute of Cancer Research (ICR) mice, weighing 25-35 g, were purchased from 

Koatec Co. (Pyeongtaek, Korea). After arrival, the mice were housed in an animal facility for 7 
days for acclimatization. 

2. The mice were anesthetized by intraperitoneal injection of anesthesia solution (8.5 ml/kg; 
Recipe 2). All procedures for the sweat assay were terminated within 1 h before the mice woke 

up. 
3. The mice were placed on a 37°C-heating pad in an empty cage for 5 min without any stimulus 

(e.g., noise and light) for stabilization of anesthesia. 

4. The anesthetized mice were carefully transported into a mouse restrainer (Equipment 7) and 

covered using a screw-lid. 
 

B. Drug administration 
1. The drug solutions (pilocarpine, glycopyrrolate, BoNT/A, myricetin, and M-LNP, see the Recipes 

section) were prepared and warmed to 37°C immediately before administration. If needed, the 
drug solutions were sterilized by passing through a 0.2-μm syringe filter before use. 

2. Administration of the drug solution after stabilization of anesthesia 
a. Application on hind footpad skin (Figure 1A) 

i. The drug solution was pipetted onto the hind footpad skin. Precautions were taken not 
to over-apply the solution. 

ii. A mouse-containing restrainer was placed on the heating pad for 30 min to allow 
sufficient time for absorption and action of the agents. 

b. Subcutaneous injection (Figure 1B) 
i. A needle-equipped syringe was loaded with drug solution. Care was taken not to inject 

the drug solution over 20 µl to avoid excessive bulging of the skin. 
ii. To remove the air in the syringe column, the piston was pressed while keeping the 

syringe with the needle-side up. 
iii. The needle was slowly inserted into the right hind footpad skin as close to the surface 

as possible, while maintaining an almost parallel angle between the needle and the skin 
surface to avoid subcutaneous structural damage and bleeding. Thin needles (17 gauge) 

were used to minimize skin damage, and fresh needles were used every time to prevent 
infection. 

iv. The drug solution was injected and the needle was removed. If saliva secretion 
stimulants such as pilocarpine hydrochloride were used, saliva overflow was eliminated 

using a wipe to prevent suffocation. 
v. Any overflow was wiped off. 

http://www.bio-protocol.org/e4047
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vi. The mouse-containing restrainer was placed down on the heating pad for 10 min to 

allow sufficient time for action of the agents. 
 

 
Figure 1. Administration of the drugs in the sweat assay after anesthesia. A. Procedures for 

the application of the drug solutions on the skin of the right hind footpads of mice. B. Procedures for 

the subcutaneous injection of the drug solutions into the right hind footpads of mice. 
 

C. Iodine-starch test (Figure 2) 
1. After administration of the drugs (pilocarpine, glycopyrrolate, BoNT/A, myricetin, and M-LNP), 

the remainder of the solution was wiped off the footpad skin, the skin washed with warm PBS, 

and the liquid wiped off again. 
2. Using a paintbrush, the iodine solution was applied to both the left and right hind footpads and 

allowed to dry for 1 min. The paintbrush used was wider than the horizontal width of the hind 
footpads, which enabled painting of enough iodine solution at once. Further, the paintbrush was 

soaked in iodine solution before use to avoid the formation of iodine crystals resulting from 
ethanol-drying. To avoid the formation of spots with iodine crystals, which can influence the 

values of the resulting sweating area %, application was done only once. 
3. To block sweat evaporation from the skin surface, a coat of starch-oil solution was applied once 

on the footpad skin by brushing at 37°C. A different paintbrush was used for this step. To avoid 
starch aggregation during the application, the starch solution was stirred. 

http://www.bio-protocol.org/e4047
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4. Immediately after coating with the starch solution, photographs of the hind footpad were 

acquired under fixed conditions of distance, magnification, and exposure. Atmospheric 
exposure of the starch-covered hind footpads for longer than 5 min can affect the unwanted 

color change due to moisture; thus, we suggest 5 min as the time limit for determining the 
sweating area (%). 

5. Description of the test: The iodine-in-ethanol solution was first applied over the footpad skin and 
the ethanol was then evaporated for 1 min. Next, the starch-in-oil solution was applied over the 

footpad skin covered with iodine. The sweat is captured between the skin and the oil layer since 
the moisture cannot diffuse out through the hydrophobic oil layer. In turn, dissolution into the 

captured sweat makes the brownish iodine react with the starch and turns a blue-black color as 
a result of ionization to polyiodide ions. In addition, the concentrations of starch and iodine in 

the starch solution and iodine solution, respectively, are high enough to induce the blue-black 
color change if the mice sweat. 
Note: The number of solution applications, once each, is more important than the volume. 

Therefore, the color can be changed to blue-black by each serial application of the iodine and 

starch solutions only once, without any risk of a lack of color change. 

 

 
Figure 2. Iodine-starch test in the sweat assay. A. Procedures of the test. B. Illustration of an 

expected mechanism for the test. 

 
Data analysis 
 

1. Image-processing and sweating area % determination  

a. Area selection (Figure 3A): The images of the hind footpad skin of mice were individually 
processed in ImageJ and only the footpad area was cropped. 

http://www.bio-protocol.org/e4047
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b. Modifying the images (Figure 3A): “Image > Type > RGB stack”, the cropped real color 

images of the footpad skin area were converted into grayscale. 
c. Auto local threshold (Figure 3B): The grayscale images of the blue stack were adjusted by 

selecting “Image > Adjust > Auto Local Threshold” using the Phansalkar method. Radius: 
15; Parameter 1 and 2: 0; check “White objects on black background”; uncheck “Stack.” 

Black pixels in the adjusted images indicate the sweating spot on the hind footpad skin. As 
shown in Figure 3C, the Phansalkar method is the best way to select the sweating spots 

among all the modules available the Auto Local Threshold. 
Note: Do not touch any initial settings for the Auto Local Threshold except the Phansalkar 

method selection. 

d. Determination of the sweating area % (Figure 3D): The measurements were set by selecting 

“Analyze > Set Measurements” and checking “‘Area fraction” before the measurement. The 
area fraction values of the black pixels in the adjusted images were measured and recorded 

by either pressing the “Ctrl + M” keys on a keyboard or clicking “Analyze > Measure.” The 
sweating area % was calculated by subtracting the area fraction from 100%. 

 

 

http://www.bio-protocol.org/e4047
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Figure 3. ImageJ-based image-processing and measurement of the sweating area %. A. 

Area-selection of the mouse footpad skin in the obtained image and conversion of the selected 
image into grayscale (the blue stack among red, green, and blue stacks) using RGB stack. B. 

Adjustment of the blue stack-based grayscale image using the Auto Local Threshold, according 
to the Phansalkar method, for extracting the sweating area. C. The adjusted images using all 

the modules for the Auto Local Threshold, including the Bernsen, Contrast, Mean, Median, 
MidGrey, Niblack, Otsu, Phansalkar, and Sauvola methods. D. Establishing the method for the 

measurement of the Area fraction that is used for determining the sweating area % values. 
 

2. Assessment of the reliability of image-processing 
All the sweating area % values of each group were determined from the footpad skin images 

obtained at different predetermined times (0, 1, 2, 3, 4, and 5 min) after the iodine-starch test 
using ImageJ (Figure 4A and 4B). The reliability of the image-processing for determining the 
sweating area % values of each group was assessed using the coefficient of determination (R2) 
of the linear-fitting curves, as shown in Figure 4C. Reliable data: R2 ≥ 0.9; unreliable data: R2 < 

0.9. Unreliable datasets were excluded when determining the sweating area % values of a 
certain group. 

 

http://www.bio-protocol.org/e4047
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Figure 4. Reliability assessment of the image-processing procedures for determining the 
sweating area %. A. Procedures for the representative image-processing of the right hind 

footpad skin that is not administered with any drug (non-treatment) for 5 min after the initiation 
of the iodine-starch test. B. Area fraction values (%Area) determined 0, 1, 2, 3, 4, and 5 min 

after the procedures for the representative image-processing. C. The linear-fitting curves for the 
sweating area % values of non-treatment, negative control (Pilocarpine) and positive control 
(Glycopyrrolate) groups. Data are expressed as the mean ± SD (standard deviation; n = 5). 

 

3. Statistical analysis and plotting the graph for the sweating area % 
All data from the sweat assay are reported as the average and standard deviation (SD) of at 

least five independent mouse experiments. Statistical analyses were performed using a 
Student’s t-test with SPSS Statistics. The bar graph including the average and SD of the 

sweating area % value for each mouse group was generated using SigmaPlot 10.0 (Figure 5). 
 

http://www.bio-protocol.org/e4047
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Figure 5. Representative sweating area % values of the mouse hind-footpad skin 5 min 
after the iodine-starch test. Sweating area % values (%Area of black pixel fraction) on (A) 

right hind footpads, directly treated (by either subcutaneous injection or applied on the skin), 

and (B) left hind footpads, not treated with drug. Groups: no treatment, PBS (0.8 ml/kg), 
pilocarpine HCl (2.5 mg/kg, negative control), glycopyrrolate bromide (0.25 mg/kg, positive 

control), BoNT/A (0.8 U/kg, positive control), myricetin (M; 0.8 mg/kg), and M-LNP (myricetin-
loaded lipid nanoparticle; 0.8 ml/kg). Data are expressed as the mean ± SD (n = 5; Student’s t-

test; ns, non-significant; *, P < 0.05; **, P < 0.01). 

 

4. Assessment of the focal anti-perspiratory effect of drugs 
Sweating area % values for left hind footpads, to which drugs were not administered, are 

represented as separate graphs to assess the circulatory-system or topical efficacy of the drugs. 
Herein, the sweating area % reduction in both the right and left footpads indicates the 

circulatory-system anti-perspiration efficacy of the drug, whereas that only in the right footpad 
indicates the topical efficacy. 

 
Recipes 
 

1. Rumpun solution 

Rumpun (xylazine hydrochloride, 23.32 mg/ml) diluted with PBS to 20 mg/ml xylazine 
hydrochloride 

2. Anesthesia solution 
Mixture of Alfaxan and Rumpun solution at a volumetric ratio of 16:1 

3. Pilocarpine solution 
Pilocarpine hydrochloride diluted with PBS to 3.125 mg/ml 

4. Glycopyrrolate solution 

http://www.bio-protocol.org/e4047
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Glycopyrrolate bromide diluted with PBS to 312.5 μg/ml 

5. Myricetin solution 
5% (w/v) myricetin solution (in DMSO) diluted with PBS to 1 mg/ml immediately before 

administration to prevent crystal formation 
6. Myricetin-loaded lipid nanoparticles (M-LNPs) 

M-LNPs prepared using the method previously reported by our group (Ban et al., 2020); 

concentration of myricetin in the M-LNP system: 1 mg/ml 

7. Starch solution 
10% (w/v) starch dispersed in castor oil and vortexed immediately before use to prevent 

sedimentation 
8. Iodine solution 

3.5% (w/v) iodine dissolved in ethanol 
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